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1. Perkenalan

1. Perkenalan

layar utama OpenOffice Impress terdiri dari 3 bagian; Slides Pane, Workspace, dan Task 
Pane. Sebagai tambahan, beberapa toolbar dapat ditampilkan atau disembunyikan ketika 
sedang membuat sebuah presentasi.

Tips:

Untuk memperlebar ruang kerja (bagian Workspace) kita dapat menutup bagian Slides 
pane atau Task pane dengan mengklik X pada pojok kanan atas dimasing-masing bagian 
jendela.

I. Slide Pane (jendela Slide)

Bagian ini menampilkan slide-slide yang ada pada dokumen presentasi. Daftar slide yang 
ada ditampilkan sesuai dengan urutan yang ingin ditampilkan. Untuk fungsi-fungsi Slide 
pane hampir mirip dengan fungsi pada MsOffice Frontpage.

Beberapa aksi yang dapat dilakukan pada jendela slide adalah;

• Menambahkan slide baru pada dokumen presentasi yang ada, setelah slide pertama

• Memberikan tanda pada slide tertentu agar tidak ditampilkan pada presentasi
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gambar 1: Mengenali bagian OpenOffice Impress

Slides Pane
Workspace Task Pane



1. Perkenalan

• Mengubah nama tiap slide didalam dokumen presentasi

• Menggandakan (copy) atau memindahkan (move) isi dari sebuah slide ke slide lainnya.

II. Task Pane (Jendela Operasi)

Pada Task pane terdiri dari 4 bagian, yaitu:

1) Master Pages; dibagian ini kita dapat menentukan style presentasi yang digunakan. 
Secara default OpenOffice menyertakan 4 template yang dapat digunakan. Untuk 
penambahan template dapat didownload.

2) Layout;  Layout pada presentasi, OpenOffice menyediakan 20 model layout yang 
berbeda. Gunakan sesuai kebutuhan.

3) Custom Animation;  bagian ini terdapat berbagi macam efek animasi yang dapat 
digunakan pada setiap elemen didalam slide.  Cara membuat  efek animasi  akan 
dibahas pada bagian selanjutnya.

4) Slide  Transition;  Efek  pegantian  slide.  OpenOffice  menyediakan  56  efek  
pergantian  slide  yang berbeda.  Juga  ada pengaturan kecepatan  pergantian slide 
(slow, medium, fast). Dibagian ini juga untuk menentukan apakah pergantian slide 
secara otomatis dengan rentang (delay) waktu tertentu atau pergantian slide dengan 
cara manual (slide akan berganti ketika di klik)
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gambar 2: bagian task 
Pane



1. Perkenalan

III. Workspace

Workspace memiliki 5 tab menu; Normal, Outline, Notes, Handout, dan Slide Order. 5 
tab  menu  ini  disebut  juga  sebagai  View  Button  (Tombol  Peninjau).  Selain  itu  juga 
banyak toolbar yang dapat digunakan selama membuat presentasi. Untuk melihat toolbar 
yang tersedia klik menu View > Toolbars. 

Berikut fungsi bagian pada tab menu;

• Normal View adalah tampilan utama untuk membuat slide satu demi satu. Tampilan ini 
digunakan untuk merancang slide dan memberikan teks, gambar, dan efek animasi

• Outline View menampilkan judul topik, list bullet, dan list nomor untuk tiap slide yang 
ada pada format outline. Gunakan modus outline untuk mengatur ulang urutan slide, 
mengedit judul dan heading, dan mengatur urutan item-item yang ada didalam list, dan 
juga untuk menambahkan slide baru
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gambar 3: Normal view pada workspace



1. Perkenalan

• Notes  view Untuk menambahkan catatan  pribadi  pada  tiap  slide  namun tidak  akan 
ditampilkan pada presentasi

• Slide order view menampilkan thumbnail dari tiap urutan slide. Gunakan tampilan ini 
untuk  mengatur  urutan  slide,  menciptakan  slide  show,  atau  mengatur  animasi 
perpindahan antara slide yang satu dengan yang lain 
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gambar 4: Outline pada workspace

gambar 5: Notes view pada workspace

gambar 6: Slide Order view pada workspace



1. Perkenalan

• Handout  view digunakan  untuk  mencetak  slide  dalam  bentuk  kertas.  Kita  dapat 
mengatur  satu  halaman  terdiri  dari  satu,  dua,  tiga,  empat,  lima,  atau  enam  slide. 
Pengaturan pada Task Pane > Layouts

Langkah Untuk mencetak handout:

1) Pilih menu File > Print atau [Control +P] untuk membuka jendela dialog print

2) Pilih Option pada bagian pokok kiri bawah dari jendela dialog print

3) Beri tanda cek (√) Handouts pada bagian Contents. Hilangkan tanda cek pada 
bagian lainnya. kemudian klik OK 

4) Klik OK untuk menutup jendela dialog

2. Membuat Presentasi

I. Menggunakan Presentation Wizard

Kita dapat memulai menggunakan Impress dengan beberapa cara:

• Dari Start Menu Application, pilih Openoffice Impress

• Apabila  sebelumnya anda telah membuka OpenOffice apa saja,   klik  segitiga kecil 
disamping icon new, selanjutnya pilih Presentation
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gambar 7: Handout view pada workspace

Task > Layouts



2. Membuat Presentasi

• Pada saat memulai pertama kali OpenOffice Impress, Wizard akan muncul. Anda dapat 
melewati  wizard  dengan  langsung  mengklik  Create,  atau  mengikut  wizard  yang 
disediakan langkah demi langkah dengan mengklik tombol Next

memilih template yang tersedia

Selanjutnya menentukan efek pergantian slide

Selanjutnya  penggunaan  OpenOffice  Impress  hampir  sama  dengan  menggunakan 
Ms.Office PowerPoint
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gambar 8: New presentation

gambar 9: wizard pertama

gambar 10: wizard kedua memilih template



2. Membuat Presentasi

II. menambahkan Template Baru

Secara default OpenOffice hanya menyertakan 4 template biasa. Agar tampilan presentasi 
dapat  lebih  menarik,  kita  dapat  menambahkan  template-template  baru.  Silahkan 
mengambil  beberapa  contoh  template  pada  link  ini 
http://repo.ugm.ac.id/ekstra/impress_templates.zip

Silahkan ekstrak template tersebut, dan selanjutnya akan kita masukkan kedalam template 
openoffice.

Untuk menambahkan template ada 2 cara, yaitu:

1) cara  pertama  adalah  dengan  mengkopikan  semua  isi  template  yang  telah 
didownload  ke  folder  /home/[nama_user]/.openoffice/user/template.  Secara 
otomatis file template tersebut akan terbaca pada OpenOffice Impress, bagian Task 
Pane > Master

2) Cara kedua adalah dengan memilih menu file > Template > Organize

3) kemudian klik  Commands > Import Template.  Pilih semua template yang telah 
didownload sebelumnya. Semua template yang telah dimasukkan akan ada didalam 
folder My Templates

III. Menambahkan Objek dan Fontwork Gallery

Pada presentasi kita dapat menambahkan gambar/object serta tulisan dalam bentuk lebih 
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gambar 11: memilih animasi

gambar 12: menambahkan template baru

http://repo.ugm.ac.id/~manda/impress_templates.zip


2. Membuat Presentasi

menarik agar enak dilihat

IV. Menambahkan Efek Animasi

Efek animasi dapat ditambahkan pada tiap bagian didalam slide baik gambar maupun 
text. Efek animasi juga dapat ditambahkan pada tiap slide, untuk menentukan efek dalam 
pergantian slide.

Custom Animation  dapat dilihat pada bagian Task Pane > Custom Animations. Untuk 
menciptakan animasi pada bagian isi didalam slide

Sedangkah  Slide Animations  dapat diihat pada  Task Pane > Slide Transitions.  Untuk 
menciptakan animasi pada saat perpindahan antar slide.
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gambar 13: membuat efek animasi



2. Membuat Presentasi

1. Efek Perpindahan Antar Slide

1) Pada Task Pane, pilih  Slide Transition  (lihat 
gambar 14 ) 

2) Dalam modus  Slides  pane  atau  Slide  sorter, 
pilih  slide yang diinginkan untuk diterapkan 
efek perpindahan. Apabila mengingikan efek 
perpindahan untuk semua slide yang ada, kita 
tidak perlu melakukan seleksi

3) Selanjutnya  kita  dapat  memilih  efek  transisi 
yang diinginkan untuk seluruh slide yang ada, 
seperti gambar disamping

4) Kustomisasikan efek perpindahan pada bagian 
Modify transition, pada bagian ini kita dapat 
mengubah  kecepatan  dan  memberikan  suara 
tambahan.

5) Apabila  anda  mengingikan  suara  efek  suara 
terus  dimainkan  berulang-ulang,  beri  tanda 
cek (√) pada bagian Loop until next sound 

6) Selanjutnya pada bagian  advance slide anda 
dapat mengatur transisi antar slide dengan tiap 
mengklik  mouse  (manual)  atau  otomatis 
sesuai  dengan  waktu  jeda  yang  telah 
ditentukan

7) Klik  tombol  Apply  to  All  Slides  untuk 
menerapkan  pengaturan  efek  perpindahan 
slide yang kita inginkan

8) Tekan tombol  Play  untuk meninjau  kembali 
tampilan  efek  perpindahan  antar  slide  yang 
telah kita buat sebelumnya

9) Tekan  tombol  Slide  Show  untuk  memulai 
slide  show,  agar  kita  dapat  melihat 
keseluruhan transisi

gambar 14. pengaturan efek 
transisi slide

2. Menghilangkan Efek Transisi Slide

1) Pilih slide yang diinginkan

2) Kemudian pilih No Transition pada bagian list Slide Transition di Tasks pane

3. Memulai Efek Animasi

Ada  3 aksi yang dapat digunakan untuk memulai efek animasi:

Pertama-On click : Efek animasi akan berhenti dan akan mulai lagi apabila mouse diklik

Kedua-With previous : Efek animasi berjalan bersamaan dengan efek animasi sebelumnya
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2. Membuat Presentasi

Ketiga-After previous  :  Efek animasi berjalan segera setelah efek animasi sebelumnya 
berakhir

4. Studi Kasus:Membuat Banyak Efek Animasi

Sebagai contoh, kita membuat efek animasi pada 4 baris kata, kemudian mengubah warna 
4 kata tersebut.

Langkah 1. Terapkan efek “fly in” pada tiap-tiap list item

1) Tampilkan bagian Custom Animations pada bagian Task pane

2) Buat slide baru dengan beberapa item list didalamnya, seperti yang terlihat pada 
gambar 15

gambar 15. Membuat item list dan Custom animation

3) Selanjutnya  beri  seleksi  pada  4  baris  list  tersebut,  lalu  klik  tombol  Add  pada 
bagian Custom animations pane

4) Akan muncul kotak dialog  Custom animation  (gambar  16).  Pilih animasi  Fly in 
dengan kecepatan animasi Medium kemudian klik OK
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2. Membuat Presentasi

5) Efek  animasi  yang telah  kita  tentukan sebelumnya  akan muncul  pada  halaman 
Custom animations, seperti gambar 17 dibawah
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gambar 16.Kotak dialog Custom animation

gambar 17. Daftar animasi yang telah 
ditentukan



2. Membuat Presentasi

Langkah 2. Terapkan efek 'change font color' untuk beberapa item 
list 

Selanjutnya kita menerapkan pada 3 item list pertama agar berganti warna ketika muncul 
pada slide. Langkah-langkahnya sebagai berikut:

1) Seleksi 3 item list pertama pada slide, kemudian klik tombol  Add pada  Custom 
Animations pane. 

2) Pada kotak dialog Custom Animation pilih tab Emphasis kemudian pilih Change 
Font Color, seperti gambar 18 dibawah

3) Perhatikan  3  list  animasi  yang  telah  diterapkan  muncul  pada  halaman  Custom 
animations (gambar 17) di bagian paling bawah animations list, dan icon “type of  
effect”  unutk 3 efek ini terlihat berbeda dengan 4 efek animasi sebelumnya

4) Kita juga dapat  mengganti  warna masing-masing list  item menjadi warna yang 
berbeda,  sesuai dengan keinginan. Pilih  Font color  list  pada  Custom Animation 
pane

5) Kita juga dapat mengubah urutan animasi dengan mengklik tombol Change order, 
dengan memilih pada salah satu animasi yang ada, kemudian mengklik kebawah 
atau keatas

6) Pada  tiap-tiap  animasi,  kita  juga  dapat  mengubah  menjadi  modus  On  click. 
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gambar 18. memilih efek emphasis

gambar 19. list efek animasi yang diterapkan



2. Membuat Presentasi

Artinya animasi baru akan berjalan apabila kita mengklik mouse. Pilih salah satu 
item kemudian pilih opsi  On Click  dari  Start list. Sekarang animations list akan 
tampak seperti gambar 21 dibawah

7) Selanjutnya simpan file [Ctrl+s], tipe file menggunakan format openoffice impress 
atau menggunakan format Ms.PowerPoint (.ppt)

8) Coba animasi yang telah anda rancang dengan menekan tombol Slide Show

5. Menghapus Efek Animasi

1) Pada bagian Custom Animations dari Task pane , pilih objek yang ingin diinginkan

2) Kemudian klik tombol Remove untuk menghapus efek animasi tersebut

Masih  banyak  pilihan-pilihan  menarik  yang  disediakan  OpenOffice  Impress  untuk 
merancang  sebuah  presentasi  dengan  animasi.  Silahkan  bereksperimen  dalam 
menambahkan efek animasi pada presentasi yang anda miliki

3. Membuat Slide Dinamis

Tutorial Penggunaan Open Office Impress 15

gambar 20. Mengubah urutan animasi

gambar 21. mengubah animasi menjadi modus On Click



4. Menggunakan Spreadsheet dan Diagram

4. Menggunakan Spreadsheet dan Diagram

5. Mencetak Dokumen

I. Mencetak Cepat

Untuk mencetak langsung klik icon  untuk mengirim seluruh dokumen agar dicetak 
pada default printer yang telah ditentukan pada komputer anda.

II. Mencetak Biasa

Untuk mencetak dokumen, impress menyediakan beberapa pilihan; seperti mencetak satu 
slide per  halaman,  mencetak dengan catatan,  outline,  waktu dan tanggal  serta  dengan 
beberapa pilihan mencetak lainnya.

Pilih File > Print untuk menampilkan kotak dialog print.

Untuk beberapa pilihan apa saja yang ingin dicetak pada dokumen pilih  Options  pada 
bagian kiri bawah.
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gambar 22: Jendela dialog printing



5. Mencetak Dokumen

Berikut keterangan bagian-bagian pilihan untuk mencetak dokumen presentasi;

1. Contents

1) Drawing mencetak satu slide per halaman,full halaman, cetak melintang

2) Outline mencetak  dengan  menyertakan  judul  dan  heading  pada  tiap-tiap  slide 
dalam bentuk outline

3) Notes mencetak  sebuah  slide  tiap  halaman  dengan  catatan  tambahan  yang 
diberikan pada halaman slide pada bagian Notes View

4) Handouts mencetak slide dengan memperkecil halaman slide, agar satu halaman 
cetak dapat memuat sampai 6 slide presentasi. Untuk menentukan berapa banyak 
slide  yang  dicetak  pada  tiap  halaman,  pada  jendela  utama  pindah  ke  bagian 
Handout  View  kemudian  pilih  bagian  Format > Modify  Layout.  Klik  gambar 
thumbnail yang menunjukkan jumlah slide yang dapat dicetak tiap halaman, sesuai 
yang diinginkan, kemudian klik  OK. Selanjutnya ikuti  instruksi mencetak pada 
bagian ini dan pilih Handouts

2. Quality

1) Default mencetak file presentasi secara default. Sesuai dengan warna yang dimiliki 
pada printer dan warna yang diberikan pada file presentasi

2) Grayscale, menganggap yang dimiliki  file presentasi  hanya memiliki satu warna 
saja. Jadi hasil yang dicetak tidak berwarna.

3) Black & white mencetak warna putih, hitam, dan grayscale namun tidak mencetak 
bagian yang berwarna.

3. Print

1) Page name, ketika mencetak juga menyertakan nama slide pada tiap halaman. 

2) Date, ketika mencetak juga menyertakan tanggal saat tersebut pada tiap halaman. 

3) Time juga mencetak menyertakan waktu saat tersebut

4) Hidden pages juga mencetak halaman slide yang diberi tanda (mark) hidden pada 
presentasi
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gambar 23: Opsi pada bagian printing



5. Mencetak Dokumen

4. Page Options 

1) Default, mencetak sesuai dengan ukuran default.

2) Fit To Page, mencetak pas pada halaman kertas, apabila ukuran slide kecil maka 
akan dicetak pas para kertas

3) Tile  Pages,  Apabila  halaman  slide  lebih  kecil  maka  dimungkinkan  terdapat 
beberapa slide yang dicetak pada satu halaman

4) Brochure, mencetak dengan model brosur

6. Export File ke PDF

OpenOffice mempunyai fasilitas untuk mengeksport file yang telah kita buat ke PDF.

I. Eksport Cepat ke PDF  

Klik icon  pada bagian toolbar atas untuk mengeksport dokument yang kita miliki ke 
format PDF dengan settingan default.

II. Export ke PDF Secara Terkontrol

Untuk  mengeskport  file  ke  PDF dengan  menentukan  beberapa  opsi,  gunakan  File  > 
Export PDF. Selanjutnya akan muncul kotak dialog PDF Options . Bagian ini memiliki 
4  bagian  halaman,  dan  masing-masing  memiliki  fungsi  yang  berbeda  yang  dapat 
ditentukan sesuai dengan kebutuhan pengguna.

1. Bagian General Pada Kotak Dialog PDF Options

Pada bagian General (lihat gambar dibawah), kita dapat menentukan halaman mana saja 
yang ingin disertakan pada file PDF, tipe kompresi yang digunakan (yang menentukan 
kualitas gambar pada PDF), dan beberapa pilihan lainnya.
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6. Export File ke PDF

Bagian Range 

• All: Export seluruh halaman dokumen

• Pages : Untuk mengeksport sebagian halaman menjadi PDF

• selections : Mengeksport semua bagian pada file yang terseleksi menjadi PDF

Bagian Images

• Lossless  compression:  Gambar  yang  dieskport  menjadi  PDF kualitasnya  sama 
dengan pada file aslinya.  Gambar pada PDF akan terlihat bagus, namun ukuran 
file akan menjadi lebih besar 

• JPEG compression: Kita dapat menentukan tingkat kualitas gambar pada file PDF 
sesuai  dengan  kebutuhan.  Meskipun  kualitas  gambar  terlihat  menurun,  namun 
ukuran file dapat ditekan.

• Reduce image resolution:  Kita dapat mengurangi DPI  (Dots Per Inch)  gambar 
aslinya pada file PDF. Namun kualitas gambar juga menjadi berkurang

Bagian General

• Tagged PDF: Menyertakan tag-tag khusus dalam tag PDF yang sesuai. Beberapa 
tag yaitu mengeksport daftar isi, hyperlinks, dan controls. Namun pilihan ini dapat 
memperbesat ukuran file

• Export  notes:  Mengeskport  catatan  pada  dokumen  Writer  atau  Calc  sebagai 
catatan PDF. Fitur ini jarang digunakan

• Export bookmarks: Mengeksport headings sebagai 'bookmark' pada PDF

• Create PDF form - Submit format

• Export  automatically  inserted  blank pages:  bagian  ini  tidak  digunakan  pada 
impress

2. Bagian Initial Views Pada Kotak Dialog PDF Options

Pada bagian ini berfungsi untuk menentukan bagaimana file akan ditampilkan pertama 
kali pada saat dibaca oleh PDF viewer (seperti Acrobat Reader). Bagian ini tidak begitu 
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gambar 24: export pdf options



6. Export File ke PDF

penting

3. Bagian User Interface Pada Kotak Dialog PDF Options 

Pada bagian ini, kita dapat menentukan lagi lebih banyak setting yang dapat dilakukan 
pada saat PDF viewers menampilkan file PDF tersebut. Beberapa pilihan sangat berguna 
apabila kita membuat PDF yang akan digunakan sebagai file presentasi atau display

Bagian Window options

• Resize window to initial  page. Jendela PDF Viewer akan sesuai dengan besar 
halaman pertama file PDF tersebut

• Center  window  on  screen. Jendela  PDF  viewer  akan  otomatis  terletak  pada 
bagian tengah layar komputer

• Open in full screen mode. Jendela PDF viewer  akan otomatis membuka dengan 
modus fullscreen

• Display document title. Jendela PDF viewer  akan menampilkan judul document 
pada bagian title bar.
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gambar 25: bagian initial views

gambar 26: bagian user interface



6. Export File ke PDF

Bagian User interface options

• Hide menubar. Jendela  PDF viewer   akan  menyembunyikan  menu  bar  secara 
otomatis.

• Hide toolbar. endela PDF viewer  akan menyembunyikan toolbar secara otomatis.

• Hide  window  controls. endela  PDF  viewer   akan  menyembunyikan  jendela 
control, termasuk efek khusus pergantian slide pada impress

4. Bagian Security page Pada Kotak Dialog PDF Options

Kita  juga  dapat  menerapakan password untuk  mengenkripsi  dokumen PDF yang kita 
miliki  (tidak  dapat  dibuka  tanpa  menggunakan  password)  dan  menerapkan  beberapa 
aturan DRM (Digital Rights Management) 

Fitur-fitur keamanan yang dapat digunakan yaitu;

• open password, file PDF hanya dapat dibuka dengan menggunakan password

• permissions password, file PDF dapat dibaca oleh semua orang, namun dengan ijin 
terbatas

• dengan mengaktifkan  open password  dan  permission password,  file PDF hanya 
dapat dibaca dengan memasukkan password dan dengan ijin yang terbatass
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gambar 27: bagian keamanan DRM



6. Export File ke PDF
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gambar 28: memasukkan password baru
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